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About this Manual

The texts, illustrations, diagrams, and examples in this manual 
are only intended as aids to help explain the functioning, 

operation, use, and programming of FR-Configurator2 
for FR-A820/FR-A840/FR-A842/FR-F820/FR-F840/FR-F842.

If you have any questions regarding the installation and operation of the
software described in this manual, please do not hesitate to contact your

sales office or one of your Mitsubishi distribution partners.
You can also obtain information and answers to 

frequently asked questions from our Mitsubishi website under
http://eu3a.mitsubishielectric.com

MITSUBISHI ELECTRIC EUROPE B.V. 
reserves the right to change the specifications of
its products and/or the contents of this manual 

at any time and without prior notice.
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Typographic conventions

Use of notes

Notes containing important information are clearly identified as follows:

Use of examples

Examples containing important information are clearly identified as follows:

Numbering in figures and illustrations

Reference numbers in figures and illustrations are shown with white numbers in a black circle and the
corresponding explanations shown beneath the illustrations are identified with the same numbers,
like this:
� � � �

Procedures

In some cases the setup, operation, maintenance and other instructions are explained with numbe-
red procedures. The individual steps of these procedures are numbered in ascending order with black
numbers in a white circle, and they must be performed in the exact order shown:

� Text

� Text

� Text

Footnotes in tables

Footnote characters in tables are printed in superscript and the corresponding footnotes shown be-
neath the table are identified by the same characters, also in superscript.

If a table contains more than one footnote, they are all listed below the table and numbered in ascen-
ding order with black numbers in a white circle, like this:

� Text
� Text
� Text

NOTE Note text

Example � Example �



Introduction Before using this software
1 Introduction

This instruction manual gives handling information and precautions for the use of this software. In-
correct handling might cause an unexpected fault. Before using the software, please read this manual
carefully to use the software to its optimum performance.

Please forward this manual to the end user. 

When reading this manual, note the following: 

Microsoft Windows and Excel are registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

● The formal name of Windows® XP is Microsoft® Windows® XP operating system.

● The formal name of Windows Vista® is Microsoft® Windows Vista® operating system

● The formal name of Windows® 7 is Microsoft® Windows® 7 operating system.

● The formal name of Windows® 8 is Microsoft® Windows® 8 operating system

● "FR Configurator2" is a registered trademark of Mitsubishi Electric Corporation.

● The copyright and other rights of this software all belong to Mitsubishi Electric Corporation.

No part of this manual may be copied or reproduced without the permission of Mitsubishi Electric Corporation.

1.1 Before using this software

NOTES If a file name or folder name is using Unicode, file writing or reading may not be performed cor-
rectly. Please use a file name and folder name without Unicode.

The following functions are not compatible with this software:
● Application starting with Windows®compatibility mode
● Starting using "Run As..."
● Fast User Switching
● Remote Desktop
● Large font size (Advanced setting of screen property)
● DPI setting other than the normal size (Advanced setting of screen property)
● Windows® XP Mode
● Windows® Touch.

A part of this software is using a function of Internet Explorer. This software may not operate prop-
erly depending on Internet Explorer setting.

FR Configurator2 is not available when inverter is activated with FR-PU07BB Battery mode. 
FR Configurator2 may not operate properly.

This manual is written on the basis that Windows® 7 Professional is the operating system.
FR Configurator2  1 - 1



Before using this software Introduction
E
Warning! 

Although this product was manufactured under conditions of strict quality control, you are
strongly advised to install safety devices to prevent serious accidents when it is used in facilities
where breakdowns of the product are likely to cause a serious accident. 

This product has not been designed or manufactured for the use with any equipment or system
operated under lifethreatening conditions. 

Please contact our sales office when you are considering using this product in special applica-
tions such as passenger mobile, medical, aerospace, nuclear, power or undersea relay equip-
ment or system.
1 - 2



Introduction Before using this software
Check the settings before configuring the inverter 

Check the following settings before configuring the inverter with this software. For the details of com-
munication parameters, refer to chapter 1.4. 

 Fig. 1-1: Check the settings before configuring the inverter

.

.

Operation steps

Check the system
configuration

Install
FR Configurator2

Connecting with
which method?

The parameter settings
can be used with the

initial values.

Set Pr. 548 USB communication 
check time interval = "9999".

Set the station number (when connecting
multiple inverters) in Pr. 331 RS-485

communication station number.
Set Pr. 336 RS-485 communication check time interval ≠ "0" and.8

Pr. 337 RS-485 communication waiting time setting = "9999".

Set the operation
mode to PU operation

mode.
Set the operation

mode to NET operation
mode.

Start FR Configurator2

USB connection Connection using RS-485 terminal

Connection using
PU connector
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System requirements Introduction
1.2 System requirements

1.2.1 Minimum system requirements

� Windows is a registered trademark of Microsoft Corporation in the United States and other
countries. Pentium is a registered trademark of Intel Corporation.

� FR Configurator2 may not function properly depending on the using personal computer, periph-
eral devices, and software.

� Operation on an operating system not listed here is not guaranteed.Windows® ist eine registrierte
Marke der Microsoft Corporation. Pentium® ist eine registrierte Marke der Intel Corporation.

Components Description �

PC �

IBM PC/AT compatible machine with DVD drive (for installation), USB port or serial port

OS �

Windows® 7, Windows® 8, Windows® 8.1/Pro/Enterprise 
(32-bit Edition and 64-bit Edition)
Windows Vista® (32-bit Edition)
Windows® XP Professional SP3 or later (32-bit Edition)
Windows® XP Home Edition SP3 or later

Processor Desktop PC: Intel® Celeron® Processor 2.8 GHz or higher
Laptop PC: Intel® Pentium® M Processor 1.7 GHz or higher

Memory

1 GB or more (Windows® 7, Windows® 8, Windows® 8.1 32-bit Edition)
2 GB or more (Windows® 7, Windows® 8, Windows® 8.1 64-bit Edition)
512 MB or more (Windows Vista®)
128 MB or more (Windows® XP Professional, Windows® XP Home Edition)

Hard disk Free area of 1.5 GB or more

Software Internet Explorer 5.0 or later

Display Applicable to display at resolution of 1024 ? 768 or more, and 256 colors or more. Compatible with 
the above personal computer.

Keyboard Compatible with the above personal computer.

Mouse Compatible with the above personal computer.

Printer Compatible with the above personal computer.

Tab. 1-1: Minimum system requirements
1 - 4



Introduction System requirements
1.2.2 System configuration

The following devices are required to use FR Configurator2. Set up the system in accordance with the
instruction manual of each device.

� When using serial port of a personal computer, a commercially available converter is required.
Examples of product available on the market (as of November 2013)
Model: DINV-CABV (with connectors and cable)
Diatrend Corp.
The converter cable cannot connect two or more inverters (the computer and inverter are
connected on a 1:1 basis). This is a RS- 232C/RS-485 conversion cable with built-in converter. No
additional cable or connector is required. Contact a manufacturer for details of the product.

� Connection cable
Examples of product available on the market (as of November 2013)
Connector: RJ45 connector
Example: Tyco Electronics
5-554720-3
Cable: Cable in compliance with EIA568 (such as 10BASE-T cable)
Example: Mitsubishi Cable Industries, Ltd.
SGLPEV-T (Cat5e/300 m) 24 AWG ? 4 P

� USB/RS-485 convert cable
Examples of product available on the market (as of November 2013)
Model: DINV-U4
Diatrend Corp.
Refer to page 38 for the communication setting with DINV-U4. When using USB/RS-485 convert
cable, use the newest driver software. For a product details or the newest driver software, contact
the cable manufacturer.

	 Recommended USB cable for computer-inverter connection
MR-J3USBCBL3M Cable Length 3 m

 Fig. 1-2: System configuration

FR Configurator2 Serial
port

USB connector or 
Serial port

Using USB connector 	




Printer

USB/RS-485-
Converter �

Connection cable
RS-485/RS-422�

RS-422
communication 

unit �

Multidrop link system

RS-485 RS-485 RS-485 RS-485 RS-485

PU connector

USB connector

Inverter Inverter Inverter Inverter Inverter

Converter �
RS-485cable �




USB connec-
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Installation and uninstallation Introduction

 Communication with PU connector, RS-485 terminal, or USB connector is available.
� Maximum overall length of connection cable: 500 m

 The USB or a serial port (one of ports 1 to 63) can be used as the communication port. Set the

communication port in the Communication settings screen of FR Configurator2. (Multiple ports
cannot be used at the same time.) One personal computer is connected to one GOT. When using
the USB for connecting a GOT, use a dedicated cable, GT09-C30USB-5P or GT09-C20USB-5P. Only
the USB connection is available for connecting the GOT2000 series to a personal computer. For
the GOT1000 series, an RS-422 communication unit (GT15-RS4-9S) is required.

� For the compatible version of GOT or details of the RS-422/485 connection, refer to the GOT1000/
GOT2000 Series Connection Manual.

1.3 Installation and uninstallation

To use FR Configurator2, the software must be installed onto the personal computer.

1.3.1 Installation of FR Configurator2

Check the following points before the installation:

● Close any other applications that have already been running.

● For the installation, log on as an administrator (Administrator account) and start installation.

● If an inverter is connected by the USB cable, disconnect the USB cable.

● Installation files are compressed. Copying the files does not start FR Configurator2 yet. Install the
software using the setup program.

● To install the software, follow the installation procedure in Windows screen.

● In an operation system with antivirus/security software, a warning may appear when install-
ing FR Configurator2. If a warning appears, permit the installation of FR Configurator2
according to the setting procedure of your antivirus/security software.

1.3.2 Uninstallation of FR Configurator2

Open the [Start] menu of Windows, and then click [Control Panel]. Click "Programs" in the "Control
Panel" window. When "Programs and Features" window is displayed, select "FR Configurator2" to
start uninstallation. 

NOTE Uninstallation is unavailable while the application is running. Perform the uninstallation after clos-
ing the application.
1 - 6



Introduction Connection and parameter setting
1.4 Connection and parameter setting

1.4.1 Connection method

For FR Configurator2, communication via USB connector, PU connector, RS-485 terminal block, or
GOT is available. USB connection is initially selected. The Developer function is available only during
communication via the PU connector.

● USB connection (refer to chapter 1.4.2)
Connect to USB connector (mini B connector) of the inverter. 1:1 connection is supported.
Connection with using USB hub is not supported.

● Serial communication (PU connector) (refer to chapter 1.4.3)
Connect to PU connector of the inverter. Serial port/RS-485 converter (cable) or USB/RS-485
converter (cable) is required.

Fig. 1-3:
USB connection

 Fig. 1-4: Serial communication (PU connector) 

PC
(FR Configurator2)

USB connector

USB cabke

USB mini B connector

Inverter

PC
(FR Configurator2)

Serial port

Serial cable

Inverter

RS-232C <-> RS-485
converter

PU connector

USB connector

USB cable

Inverter

USB <-> RS-485
converter

PU connector

or
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Connection and parameter setting Introduction
● Serial communication (RS-485 terminal) (refer to chapter 1.4.4)
Connect to RS-485 terminal of the inverter. Up to 32 inverters can be connected.

● Communication through GOT (USB / Serial communication), refer to chapter 1.4.5)
Through a GOT (Human Machine Interface), connection to the RS-485 terminal block is available. For
the GOT1000 series, an RS-422 communication unit is required. For the compatible version of GOT or
details of the RS-422/485 connection, refer to the GOT1000/GOT2000 Series Connection Manual. 

 Fig. 1-5: Serial communication (RS-485 terminal)

 Fig. 1-6: Communication through GOT (USB / Serial communication)

NOTES Inserting or pulling out a USB cable during FR Configurator2 operation may cause the inverter to
be unrecognized. Insert and pull out the USB cable for several times, or reset the inverter with the
USB cable connected to the personal computer.

If the Pr. 999 Automatic parameter setting setting is changed to "10 or 11" using the operation
panel, parameter unit, etc. during FR Configurator2 operation, the inverter communication parame-
ters will be changed, and such setting may disable the communication with FR Configurator2.

Do not set Pr. 999 while FR Configurator2 is used. (For Pr. 999, refer to the Instruction Manual
(Detailed) of the inverter.)

Only the USB connection is available for connecting the GOT2000 series to a personal computer.

Serial port

PC
(FR Configurator2)

RS-485 terminal block Up to
32 inverters

RS-422/485

Inverter

RS-232C <-> RS-485
converter

Serial cable

PC
(FR Configurator2)

RS-485 terminal block

Up to 32 inverters can be connected.

RS-422/485

Inverter

USB connector

GOT2000

USB cable
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Introduction Connection and parameter setting
1.4.2 Connection using USB connector

To communicate with FR Configurator2 by the USB connection between the inverter and a personal
computer, use the USB mini B connector at the inverter side. 1:1 connection is supported. Connection
using USB hub is not supported.

USB mini B connector at the inverter side

Related parameters for USB connection

Set the following communication parameter when connecting the USB connector of the inverter.
When performing parameter writing or run command input, set the following command source pa-
rameters, and switch the operation mode to PU operation mode. 

Fig. 1-7:
Connection using USB connector

Item Description

Interface USB1.1

Transmission speed 12 Mbps

Wiring length Maximum 5 m

Connector USB mini B-connector (receptacle mini B type)

Recommended USB cable  MR-J3USBCBL3M (cable length: 3 m)

Tab. 1-2: Applicable cable

 Fig. 1-8: USB mini B connector at the inverter side

PC
(FR Configurator2)

USB connector

USB cable

USB mini B
connector

Inverter

USB host (A connector

USB device (mini B connector))

Communication status LED
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Connection and parameter setting Introduction
� Changed settings are enabled at the next power-ON or inverter reset.
� Pr. 551 is always write-enabled.

Inverter
Parameter setting Operation 

modeCommunication parameter  Command source parameter

FR-A800/F800 Pr.548 USB communication check time 
interval = "9999 (initial value)"

Pr.551 PU mode operation command 
source selection = "3 or 9999"

(initial value 9999)
PU

Tab. 1-3: Parameter settings for USB connection

NOTES Switching of the operation mode is available using "test operation" (refer to chapter 3.7) or
"parameter list" (refer to chapter 3.1) on the sub window.

Set a station number of the each inverter in Pr.547 USB communication station number. Perform
inverter reset after setting the parameter.

Pr. Name Initial value Setting
range Description

547
N040

USB communication 
station number �

0 0–31 Inverter station number specification.

548
N040

USB communication check 
time interval�

9999

0 USB communication is possible. Trips in the PU operation mode (E.USB)

0.1–999..88 s Sets the interval of communication check time. If a no-communication state persists for longer than the 
permissible time, the inverter trips (E.USB).

9999 No communication check

551
D013

PU mode operation command 
source selection �

9999

1 Selects the RS-485 terminal as the PU operation mode command source.

2 Selects the PU connector as the PU operation mode command source.

3 Selects the USB connector as the PU operation mode command source.

9999
USB automatic recognition
Normally, operation panel (PU connector) is the command source. During USB connection, USB is the 
command source.

NOTE Always reset the inverter after making the setting of the parameters. After you have changed the com-
munication-related parameters, communication cannot be established until the inverter reset.
1 - 10



Introduction Connection and parameter setting
1.4.3 Connection using PU connector

PU connector is used for connecting with a computer. Serial port/RS-485 converter (cable) or USB/RS-
485 converter (cable) is required. 1:1 connection is supported.

PU connector pin layout

 Fig. 1-9: Connection using PU connector

Pin number Name Description

1) SG Earth (Ground) (Connected to terminal 5)

2) — Operation panel power supply

3) RDA Inverter receive+

4) SDB Inverter send−

5) SDA Inverter send+

6) RDB Inverter receiven−

7) SG SG Earth (Ground) (Connected to terminal 5)

8) — Operation panel power supply

Tab. 1-4: PU connector pin layout

Fig. 1-10: Example with FR-A800

NOTES Pins No. 2 and 8 provide power to the operation panel or parameter unit. Do not use these pins for
RS-485 communication. (Refer to the inverter Instruction Manual for details.)

Do not connect the PU connector to the computer's LAN board, FAX modem socket or telephone
modular connector. The product could be damaged due to differences in electrical specifications.

PC
(FR Configurator2)

Serial port

Serial cable

Inverter

RS-232C <-> RS-485
converter

PU connector

USB cable

Inverter

USB <-> RS-485
converter

PU connector

or USB connector

8 1

Front view
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Connection and parameter setting Introduction
Related parameters for connection using PU connector

Set the following communication parameter when connecting PU connector of the inverter.

When performing parameter writing or run command input, set the following command source pa-
rameters, and switch the operation mode to the following operation mode.

Inverter Communica-
tion option

Parameter setting Operation 
modeCommunication parameter  Command source parameter

FR-A800/
F800 —

Pr.122 PU communication check time
interval ? "0"

Pr.123 PU communication waiting time
setting = "9999 (initial value)"

Pr.551 PU mode operation command
source selection = "2 or 9999"

(initial value 9999)
PU

Tab. 1-5: Parameters for connection using PU connector

NOTES
Set 3 s or more (or 9999) in Pr.122 PU communication check time interval.

Set a station number of the each inverter in Pr.117 PU communication station number when con-
necting multiple inverters. Perform inverter reset after setting the parameter.

Pr. Name Initial value Setting
range Description

117
N020

PU communication 
station number 0 0–31 Inverter station number specification. Set the inverter station numbers when two or more inverters are 

connected to one personal computer.

118
N021 PU communication speed 192

48, 96, 192,
384, 576,
768, 1152

Set the communication speed. The setting value ? 100 equals the communication speed.
For example, if 192 is set, the communication speed is 19200 bps.

E022 PU communication 
data length 0

0 Data length 8 bits

1 Data length 7 bits

E023 PU communication 
stop bit length 1

0 Stop bit length 1 bit

1 Stop bit length 2 bits

119 PU communication stop bit
length / data length 1

0 Stop bit length 1 bit
Data length 8 bits

1 Stop bit length 2 bits

10 Stop bit length 1 bit
Data length 7 bits

11 Stop bit length 2 bits

120
N024

PU communication 
parity check 2

0 Without parity check

1 With parity check at odd numbers

2 With parity check at even numbers

121
N025

Number of PU 
communication retries 1

0–10 Set the permissible number of retries for unsuccessful data reception. If the number of consecutive errors 
exceeds the permissible value, the inverter will trip.

9999 If a communication error occurs, the inverter will not trip.

122
N026

PU communication
check time interval 9999

0 RS-485 communication is enabled. Note that a communication fault (E.PUE) occurs as soon as the 
inverter is switched to the operation mode with control source.

0.1–999.8 s Communication check (signal loss detection) time interval. If a no-communication state persists for 
longer than the permissible time, the inverter trips (depends on Pr. 502).

9999 No communication check (signal loss detection).

123
N027

PU communication 
waiting time setting 9999

0–150 ms Set the waiting time between data transmission to the inverter and response.

9999 Set with communication data.
1 - 12



Introduction Connection and parameter setting
� Pr.551 is always write-enabled.

551
D013

PU mode operation command
source selection � 

9999

1 Selects the RS-485 terminal as the PU operation mode command source.

2 Selects the PU connector as the PU operation mode command source.

3 Selects the operation panel as the PU operation mode command source.

9999
USB automatic recognition
Normally, operation panel (PU connector) is the command source. During USB connection, USB is the 
command source.

NOTES Always reset the inverter after making the setting of the parameters. After you have changed the com-
munication-related parameters, communication cannot be established until the inverter reset.

To change an inverter parameter value, use the operation panel or parameter unit. Only one of the
operation unit and FR Configurator2 (personal computer) can be connected to the PU connector.

For details on each inverter communication parameter, refer to the Instruction Manual (Detailed)
of the inverter.

Parameter clear/All parameter clear by the operation panel or the parameter unit clears communi-
cation parameter settings and disables the communication with FR Configurator2.

Pr. Name Initial value Setting
range Description
FR Configurator2  1 - 13



Connection and parameter setting Introduction
1.4.4 Connection of multiple inverters using RS-485 terminal

RS-485 terminal is used for connecting multiple inverters with Serial port of a computer. Up to 32 in-
verters can be connected. Serial/RS-485 converter is required.

Set the following communication parameter when connecting RS-485 terminal of the inverter. When
performing parameter writing or run command input, set the following command source parame-
ters, and switch the operation mode to the following operation mode.

 Fig. 1-11: Connection of multiple inverters using RS-485 terminal

Inverter Communica-
tion option

Parameter setting Operation 
modeCommunication parameter  Command source parameter

FR-A800/
F800

No
Set the station number of the each invert-
er in Pr.331 RS-485 communication sta-

tion number (when connecting multiple 
inverters)

Pr.336 RS-485 communication check 
time interval ? "0" (initial value 0)

Pr.337 RS-485 communication waiting 
time setting = "9999 (initial value)"

Initial value NET

Yes
Pr.551 PU mode operation command 

source selection = "1"
(initial value 9999)

PU

Tab. 1-6: Parameters for multiple connection using RS-485 terminal

NOTES Always reset the inverter after making the setting of parameters. After you have changed the com-
munication-related parameters, communication cannot be established until the inverter reset.

For the details of wiring, refer to the Instruction Manual (Detailed) of the inverter.

Set 3 s or more (or 9999) in Pr.122 PU communication check time interval, Pr.336 RS-485 communi-
cation check time interval.

Set a station number of the each inverter in Pr.117 PU communication station number and Pr.331
RS-485 communication station number when connecting multiple inverters.

 

- -  
 

 

 
 

 

PC
(FR Configurator2)

Serial cable

Inverter

RS-232C <-> RS-485
converte

RS-485 terminal block

Up to 32 invertersRS-422/485

Serial port
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Introduction Connection and parameter setting
 

� Pr.551 is always write-enabled.

1.4.5 Connection through GOT (FA transparent function)

Using the FA transparent function of GOT1000/GOT2000 series, connecting an inverter to FR Configurator2
is available through GOT. 

The FA transparent function enables reading, writing and monitoring of a programmable controller
of Mitsubishi Electric Corporation through GOT, while connecting the Mitsubishi programmable con-
troller and a personal computer. A serial port or USB is used for connecting the personal computer and
GOT. RS422/485 is used for connecting GOT and the inverter.

Pr. Name Initial value Setting
range Description

331
N030

RS-485 communication 
station number 0 0–31 Set the inverter station number. Set the inverter station numbers when two or more inverters are con-

nected to one personal computer.

336
N036

RS-485 communication 
check time interval 0s

0 RS-485 communication is enabled. However, the inverter trips if operation is changed to NET opera-
tion mode.

0.1–999.8 s Set the interval of communication check (signal loss detection) time. If a no-communication state 
persists for longer than the permissible time, the inverter trips.

9999 No communication check (signal loss detection)

337
N037

RS-485 communication 
waiting time setting 9999

0–150 ms Set the waiting time between data transmission to the inverter and response.

9999 Set with communication data.

549
N000 Protocol selection 0

0 Pr.549 = “0” (Mitsubishi inverter (Computer link) protocol). Mitsubishi inverter protocol (computer link)

1 Modbus-RTU protocol

2 The setting is available only for the FR-F800 series.. BACnet MS/TP protocol

550
D012

NET mode operation 
command source selection 9999

0 The communication option is the command source when in the NET operation mode.

1 The RS-485 terminals are the command source when in the NET operation mode.

9999 Communication option is recognized automatically. Normally, the RS-485 terminals are the command 
source. When the communication option is mounted, the communication option is the command source.

551
D013

PU mode operation command
source selection � 

9999

1 Selects the RS-485 terminals as the PU operation mode command source.

2 Selects the PU connector as the PU operation mode command source.

3 Selects the USB connector as the PU operation mode command source.

9999 AUSB automatic recognition. Normally, operation panel (PU connector) is the command source. During USB 
connection, USB is the command source.

 Fig. 1-12: Example of RS-485 terminal connection (GOT2000 connection)

USB connector

PC
(FR Configurator2)

RS-485 terminal block

Up to 32 inverters can be 
connected

RS-422/485

Frequenzumrichter

USB cable

GOT2000 (GOT1000 also allows serial port 
connection)
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Connection and parameter setting Introduction
For the GOT1000 series, an RS-422 communication unit (GT15-RS4-9S) is required. When using the
USB for connecting a GOT, use a dedicated cable, GT09-C30USB-5P or GT09-C20USB-5P.

For the compatible version of the GOT or details of the RS-422/485 connection, refer to the GOT1000/
GOT2000 Series Connection Manual.

GOT2000 series automatic recognition

When the GOT2000 series is connected, the parameters required for the GOT connection are auto-
matically changed by setting the automatic recognition on the GOT2000 series side.

Set the station number (Pr.117 or Pr.331) of the inverter before the automatic recognition is per-
formed. Connect all the stations of inverters with GOT before the automatic recognition is performed.
The inverter newly added after automatic recognition will not be recognized automatically. (When an
inverter is added, perform the initial setting in Pr.999 Automatic parameter setting or set the auto-
matic recognition on the GOT side again.)

 Fig. 1-13: Example of PU connector connection (GOT1000 connection)

NOTES Do not perform the following operation while the FA transparent function is valid and FR
Configurator2 is ONLINE.
● Online operation (project download, etc.) from GT Designer/GT Designer2 to GOT
● Online operation to programmable controller CPU by using FA transparent function of GX

Developer or GX Works2

When using FA transparent communication, communication error (timeout) may occur when FR
Configurator2 starts communication during timeout occurrence in GOT (when GOT is monitoring the
inverter which is not connected). In that case, set the timeout time value more than the following.

Timeout value of GOT [s] ? (Retry count of GOT + 1)

If the value above is more than 30 [s], make adjustment to "Timeout value" [s] and "Retry count" of
GOT to make the value above become less than 30 [s].

USB connector/
Serial port

PC
(FR Configurator2)

PU connector

Terminatin-
gresistor

RS-422

Distributor

USB/serial cable

GOT1000

GOT RS-422
communication unit

Distributor

10BASE-T cable

Station 1 Station 2 Station n

Distrib#utor

(GOT2000 only allows USB con-
nection)
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Introduction Connection and parameter setting
Tab. 1-7: Automatic change parameter setting

Related parameters for connection through GOT

Set communication-related parameters automatically as follows. For connection through GOT, set Pr.
123 PU communication waiting time setting = "0", Pr. 337 RS-485 communication waiting time setting
= "0". For connection to the PU connector, set Pr.999 Automatic parameter setting = "12". For con-
nection to the RS-485 terminals, set Pr.999 = "13".

Automatic change item
Automatic change parameter setting

Setting value after change
PU connector RS-485 terminal

Communication speed Pr. 118 Pr. 332

Depending on the setting of the
connected device on the GOT side.

Data length/stop bit Pr. 119 Pr. 333

Parity Pr. 120 Pr. 334

Waiting time setting Pr. 123 Pr. 337

CR/LF selection Pr. 124 Pr. 341

Number of communication
retries Pr. 121 Pr. 335 9999 (fixed)

Communication check time
interval Pr. 122 Pr. 336 9999 (fixed)

Protocol selection
– (Pr.549 holds the val-

ue before the auto-
matic recognition.)

Pr. 549 0 (fixed to Mitsubishi inverter protocol)

NOTES
If the automatic recognition cannot be performed, initial setting in Pr.999 is required.

For connection to a device other than the GOT2000 series, initial setting in Pr.999 is required.

For details, refer to the GOT2000 Series Connection Manual (Mitsubishi Product).

Pr. Name Initial value Setting
range Description

117
N020

PU communication 
station number 0 0–31 Inverter station number specification. Set the inverter station numbers when two or more inverters are 

connected to one personal computer.

118
N021 PU communication speed 192

48, 96, 192,
384, 576,
768, 1152

Set the communication speed. The setting value ? 100 equals the communication speed.
For example, if 192 is set, the communication speed is 19200 bps.

E022 PU communication 
data length 0

0 Data length 8 bits

1 Data length 7 bits

E023 PU communication 
stop bit length 1

0 Stop bit length 1 bit

1 Stop bit length 2 bits

119 PU communication stop bit
length / data length 1

0 Stop bit length 1 bit
Data length 8 bits

1 Stop bit length 2 bits

10 Stop bit length 1 bit
Data length 7 bits

11 Stop bit length 2 bits

120
N024

PU communication 
parity check 2

0 Without parity check

1 With parity check at odd numbers

2 With parity check at even numbers

121
N025

Number of PU 
communication retries 1

0–10 Set the permissible number of retries for unsuccessful data reception. If the number of consecutive errors 
exceeds the permissible value, the inverter will trip.

9999 If a communication error occurs, the inverter will not trip.
FR Configurator2  1 - 17



Connection and parameter setting Introduction
122
N026

PU communication
check time interval 9999

0 RS-485 communication is enabled. Note that a communication fault (E.PUE) occurs as soon as the 
inverter is switched to the operation mode with control source.

0.1–999.8 s Communication check (signal loss detection) time interval. If a no-communication state persists for 
longer than the permissible time, the inverter trips (depends on Pr. 502).

9999 No communication check (signal loss detection).

123
N027

PU communication 
waiting time setting 9999

0–150 ms Set the waiting time between data transmission to the inverter and response.

9999 Set with communication data.

124
N028

PU communication CR/LF
selection 1

0 Without CR/LF

1 With CR

2 With CR/LF

331
N030

RS-485 communication 
station number 0 0–31

(0–247) Sets the inverter station number (the same specifications as Pr. 117). 

332
N031 RS-485 communication speed 96

3 to 6, 12 to
24, 48, 96,

192, 384, 576
to 768, 1152,

Select the communication speed (the same specifications as Pr. 118).

N032 PU communication data 
length 0 0/1 Select the data length. (the same specifications as Pr. N022) 

N033 PU communication stop bit
length 1 0/1 Select the data length. (the same specifications as. N023)

333 Stoppbitlänge/Datenlänge 
(RS-485-Schnittstelle) 1 0/1/10/11 Select the stop bit length. (the same specifications as Pr. 119)

334
N034

RS-485 communication stop 
bit length / data length 2 0/1/2 Select the parity check specifications. (the same specifications as Pr. 120)

335
N035

RS-485 communication 
retry count 1 0–10/9999 Set the permissible number of retries for unsuccessful data reception. (the same specifications as Pr. 121)

336
N036

RS-485 communication 
check time interval 0s

0 RS-485 communication is enabled. However, the inverter trips if operation is changed to NET operation mode.

0.1–999.8.9.0 s Set the interval of communication check (signal loss detection) time. If a no-communication state per-
sists for longer than the permissible time, the inverter trips.

9999 No communication check (signal loss detection)

337
N037

RS-485 communication 
waiting time setting 9999 0–150 ms/

9999 Set the waiting time between data transmission to the inverter and response. (the same specifications as Pr. 123)

341
N038

RS-485 communication 
CR/LF selection 1 0/1/2 Select presence/absence of CR/LF. (the same specifications as Pr. 124)

549
N000 Protocol selection 0

0� Mitsubishi inverter (computer link) protocol.

1 Modbus-RTU protocol

2� BACnet MS/TP Protocl

551
D013

PU mode operation command
source selection� 9999

1 The RS-485 terminals are the command source when in the PU operation mode.

2 The PU connector is the command source when in the PU operation mode.

3 The USB connector is the command source when in the PU operation mode.

9999
USB automatic recognition
Normally, the operation panel (PU connector) is the command source. When the USB is connected, the 
USB connector is the command source.

Pr. Name Initial value Setting
range Description
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Introduction Connection and parameter setting
� Set Pr.549 = "0" (Mitsubishi inverter (Computer link) protocol).
� The setting is available only for the FR-F800 series.
� Pr.551 can be always written regardless of the operation mode.
	 The read value is always "9999".
 

999
E431 Automatic parameter setting 9999	

1 Standard PID setting

2 Extended PID setting

10 GOT initial setting
(PU connector GOT side model selection:

FR 500/700/800,
sensorless servo11 GOT initial setting 

(RS-485 terminals)

12 GOT initial setting 
(PU connector) GOT side model selection:

FR 800
Automatic setting13 GOT initial setting 

(RS-485 terminals)

20 50 Hz rated frequency

21 60Hz rated frequency

9999 No action

NOTE Always perform an inverter reset after performing the initial setting of each parameter. After changing
the communicationrelated parameters, communication cannot be made until the inverter is reset.

Pr. Name Initial value Setting
range Description
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Setting of operation mode of the inverter Introduction
1.5 Setting of operation mode of the inverter

The inverter has three operation modes:

● External operation mode: Operation and frequency commands are given by an external potenti-
ometer and switches, via control circuit terminals.

● PU operation mode: Operation and frequency commands are given by the operation panel,
parameter unit, or RS-485 communication, via the PU connector.

● Network operation mode (NET operation mode): Operation and frequency commands are given
via the RS-485 terminals or a communication option..

Refer to the following table to select the appropriate operation mode for the connection. Switching
of the operation mode is available using "test operation" or "parameter list" on the sub window. Refer
to the Instruction Manual (Detailed) of the inverter for details of each parameter. Monitoring and pa-
rameter read can be performed from any operation regardless of the operation mode. 

Pr. 79 Operation mode at power ON, at 
power restoration, or after a reset. Operation mode switchover

0(
initial
value)

External operation mode
Switching among the External, PU, and NET operation mode is 
enabled. Operation mode cannot be directly changed between 
the PU operation mode and Network operation mode.

1 PU operation mode PU operation mode fixed.

2 External operation mode Switching between the External and NET operation mode is
enabled. Switching to PU operation mode is disabled.

3/4 External/PU combined operation mode Operation mode switching is disabled.

6 External operation mode Switching among the External, PU, and NET operation mode 
is enabled while running.

7

X12 (MRS) signal ON...External 
operation mode

Switching among the External, PU, and NET operation mode is 
enabled. Operation mode cannot be directly changed between 
the PU operation mode and Network operation mode.

X12 (MRS) signal OFF...External 
operation mode

External operation mode fixed. (Forcibly switched to Exter-
nal operation mode.)

Tab. 1-8: Operation modes of the inverter

 Fig. 1-14: Operation mode switchover

NOTE
When using USB connection, operation mode changing is available from FR Configurator2

External operation

Switching through 
the network

Switching with 
the PU

Network operation PU operation

Switch to External 
operation mode through
the network. Switch to Network operation

mode through the network.

 Press to light PU

 Press to light EXT

Network operation
Press to light PU

Press to light NET

When "10 or 12" is set inPr. 340
PU operation

When "0 .1.2.3.4.5.6.7. or 2" is set in Pr. 
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Op
er

at
io

n
lo

ca
tio

n Condition
(Pr. 551
setting)

Item

Operation mode

PU
operation

External
operation

External/PU
combined
operation 

mode 1
(Pr. 79 = 3)

External/PU
combined
operation

mode 2
(Pr. 79 = 4)

NET operation
(when RS-485
terminals) �

NET operation
(with

communication
option) 


Co
nt

ro
l b

y R
S-

48
5 c

om
m

un
ica

tio
n 

via
 P

U 
co

nn
ec

to
r

2
(PU

connector)
9999

(automatic
recognition,
without USB
connection)

Run command
(start)

✔ — — ✔ —

Run command
(stop)

✔ � � � � ✔ � �

Running frequency
setting

✔ — ✔ — —

Monitor ✔ ✔ ✔ ✔ ✔

Parameter write ✔ 	 — 
 ✔ 	 ✔ 	 — 


Parameter read ✔ ✔ ✔ ✔ ✔

Inverter reset ✔ ✔ ✔ ✔ ✔

Other than
the above

Run command
(start)

— — — — —

Run command
(stop) � � � � � � � � � �

Running frequency
setting

— — — — —

Monitor ✔ ✔ ✔ ✔ ✔

Parameter write — 
 — 
 — 
 — 
 — 


Parameter read ✔ ✔ ✔ ✔ ✔

Inverter reset ✔ ✔ ✔ ✔ ✔

Co
nt

ro
l b

y c
om

m
un

ica
tio

n v
ia 

RS
-4

85
 te

rm
in

als

1
(RS-485

terminals)

Run command
(start, stop)

✔ — — ✔ —

Running frequency
setting

✔ — ✔ — —

Monitor ✔ ✔ ✔ ✔ ✔

Parameter write ✔ 	 — 
 ✔ 	 ✔ 	 — 


Parameter read ✔ ✔ ✔ ✔ ✔

Inverter reset ✔ ✔ ✔ ✔ ✔

Other than
the above

Run command
(start, stop)

— — — — ✔ � —

Running frequency
setting

— — — — ✔ � —

Monitor ✔ ✔ ✔ ✔ ✔ ✔

Parameter write — 
 — 
 — 
 — 
 ✔ 	 — 


Parameter read ✔ ✔ ✔ ✔ ✔ ✔

Inverter reset — — — — ✔ � —

Tab. 1-9: Select the appropriate operation mode for the connection
FR Configurator2  1 - 21



Setting of operation mode of the inverter Introduction
✔:Enabled, —:Disabled, �:Some are enabled

� As set in Pr.338 Communication operation command source, Pr.339 Communication speed com-
mand source.

� At occurrence of RS-485 communication error from PU connector, the inverter cannot be reset
from the computer.

� Enabled only when stopped by the PU. At a PU stop, PS is displayed on the operation panel. As
set in Pr.75 Reset selection/disconnected PU detection/PU stop selection.

	 Some parameters may be write-disabled according to the Pr.77 Parameter write selection setting
and operating status.


 Some parameters are write-enabled independently of the operation mode and command source
presence/absence. When Pr. 77 = "1", write is enabled. Parameter clear is unavailable.

� BWhen Pr.550 NET mode operation command source selection = "1" (RS-485 terminals valid) or
Pr.550 NET mode operation command source selection = "9999" and the communication option
is not mounted.


 When Pr.550 NET mode operation command source selection = "0" (communication option valid)
or Pr.550 NET mode operation command source selection = "9999" and the communication
option is mounted.

Op
er

at
io

n
lo

ca
tio

n Condition
(Pr. 551
setting)

Item

Operation mode

PU
operation

External
operation

External/PU
combined
operation 

mode 1
(Pr. 79 = 3)

External/PU
combined
operation

mode 2
(Pr. 79 = 4)

NET operation
(when RS-485
terminals) �

NET operation
(with

communication
option) 


Op
er

at
io

n v
ia 

th
e U

SB
 co

nn
ec

to
r

3
(USB connector)

9999
(automatic

recognition,
with USB

connection)

Run command
(start, stop)

✔ — — ✔ —

Running frequency
setting

✔ — ✔ — —

Monitor ✔ ✔ ✔ ✔ ✔

Parameter write ✔ 	 — 
 — 
 — 
 — 


Parameter read ✔ ✔ ✔ ✔ ✔

Inverter reset ✔ ✔ ✔ ✔ ✔

Other than
the above

Run command
(start, stop)

— — — — —

Running frequency
setting

— — — — —

Monitor ✔ ✔ ✔ ✔ ✔

Parameter write — 
 — 
 — 
 — 
 — 


Parameter read ✔ ✔ ✔ ✔ ✔

Inverter reset ✔ ✔ ✔ ✔ ✔

Co
nt

ro
l b

y c
om

m
un

ica
tio

n
fro

m
 co

m
m

un
ica

tio
n 

op
tio

n

—

Run command
(start, stop)

— — — — — ✔ �

Running frequency
setting

— — — — — ✔ �

Monitor ✔ ✔ ✔ ✔ ✔ ✔

Parameter write — 
 — 
 — 
 — 
 — 
 ✔ 	

Parameter read ✔ ✔ ✔ ✔ ✔ ✔

Inverter reset — — — — — ✔ �

Ex
te

rn
al 

te
rm

in
al 

at
 th

e c
on

tro
l c

irc
ui

t

—

Inverter reset ✔ ✔ ✔ ✔ ✔ ✔

Run command
(start, stop)

— ✔ ✔ — —�

Running frequency
setting

— ✔ — ✔ —�

Tab. 1-10: Select the appropriate operation mode for the connection
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1.6 Start and close of FR Configurator2

1.6.1 Starting FR Configurator2

There are the following ways to start FR Configurator2.

● Start from Start menu
Click [Start] on the Taskbar of Windows, and point to [All Programs], [MELSOFT Application],
[FR Configurator2], and select [FR Configurator2] in the sub menu to start FR Configurator2.

● Start from the project file (*.frc2) 
(Refer to chapter 2.1)
Select the project file (*.frc2) and execute it (or press the Enter key). The project file settings will
be read and FR. Configurator2 will be started. Drag and drop the project file to the execution file
(FR2.exe) or to the shortcut icon of FR Configurator2. FR Configurator2 will be started.

● Start from Windows® Explorer
Select the executable file of FR Configurator2 (FR2.exe) by using Windows Explorer, and double-
click (or hit Enter key) tostart FR Configurator2.

1.6.2 Closing FR Configurator2

Close FR Configurator2 in the following procedure: 

● Select [Exit] in [File] menu to close FR Configurator2. (Press Alt + P to open [Project] menu, and
press Ctrl + F4 also to close FR Configurator2).

If a project file (*.frc2) is not saved yet when closing FR Configurator2, the dialog box is displayed to
confirm the closing.

Fig. 1-15: Start from Windows Explorer

NOTES The window „An unidentified program wants access to your computer“ may appear at the start up
of FR Configurator2. If the window appears, select "Allow ".

In an operation system with antivirus/security software, a warning may appear at starting FR
Configurator2. If a warning appears, permit FR Configurator2 according to the setting procedure
of your antivirus/security software.

If files shown in [Recent Items] of Windows Vista® and [Recent] of Windows® 7, Windows® 8 or Windows® 8.1
are stored in system folders (Program Files for example), the files may not be opened correctly.
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2 Project creation

2.1 Project file operation

2.1.1 Procedure to create a project 

The following shows the procedure from creating project to operating the functions of FR Configurator2: 

● Starting FR Configurator2
● Creating new project file (Window: System setting)
● Editing project data (Windows: Parameter list, Batch monitor, Graph, I/O terminal monitor, Test opera-

tion, Diagnostics)
● Use functions and tools (Windows: Developer, USB memory parameter copy file edit, Convert, Help)
● Saving project file.

2.1.2 Creating a new project file

Enter information required for creating a project file on the "System setting" window. Select [New] in
the [Project] menu or click on the toolbar to display the "System setting" window.

 Fig. 2-1: Details of the "System setting" window

No. Name Function / description

� System name Enter the name of the system within 32 characters.

� Connection setting Set the connection type in [PC-side port], [Port No.], [Through], and [Detailed setting].

� Model setting

For manual recognition: Select the model, capacity, and connection option of the 
inverter from the list.
For automatic recognition: Select "Auto recognize" to enable FR Configurator2 to recog-
nize the information about the connected inverter.

Tab. 2-1: Details of the "System setting" window

�

�

�
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2.2 Explanation of the operating window

2.2.1 Main frame

The main frame (main screen) of FR Configurator2 consists of two areas:

● Project tree area
An area for showing information of the registered inverter, or for making settings. "System setting",
"Graph", and "Batch monitor" are available in this area.

● Sub-window area
An area for showing obtained monitor data of the inverter. "Parameter list", "Graph", "Batch
monitor", and "Faults history" are available in this area.

 Fig. 2-2: Details of the main frame

No. Name Function / description Refer to

� Menu bar The window of each function is displayed from the menu bar. 2.2.4

� Toolbar The window of each function is displayed in the sub-window area by select-
ing an icon on the toolbar. 2.2.4

� Status bar The model name, operating status, etc. are displayed. 2.2.5

� Split line
Adjustment of the project tree area size and sub window area size is availa-
ble. To resize the project tree area and sub window area to their original size, 
from [Window] of the menu bar, choose [Reset window layout].

—

Tab. 2-2: Details of the main frame

Project tree

Sub-window

�

�

�

�
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Project creation Explanation of the operating window
2.2.2 Project tree area

The project tree area displays a list of the project data including "Parameter list" of the inverters reg-
istered in the project, "System setting", "Graph", and "Batch monitor". Select such an item to display
the window in the sub-window area.

Display and switching of the project tree area

Select [Project window] from [Docking Window] in the [View] menu to switch the display of the pro-
ject tree area among display and hidden.

 Fig. 2-3: Details of the project tree

No. Name Function / description

� Project name Displays the project name.

�

System setting Displays the system setting window in the sub-window area.

Graph Displays the graph window in the sub-window area.

Batch monitor Displays the batch monitor screen in the sub-window area.

Station number:
inverter mode

Displays the station number and the model of the inverter registered in the project.
Click "Station number: inverter model" to select the corresponding station number. The 
selected "Station number: inverter model" is highlighted in yellow. (If the main frame is not 
selected, "Station number: inverter model" is displayed in gray.)
Click "Plus" on the left of the icon to spread the tree view and display [Parameter].

�

Parameter Click [Parameter] to display the "parameter list" in the sub window area.

Motor Click [Motor] to select the window for motor setting or offline auto tuning.

Terminal Click [Terminal] to select the window for terminal calibration or function assignment.

Trace Click [Trace] to select the window for trace function setting or trace command execution.

Tab. 2-3: Details of the project tree

�

�

�

FR Configurator2  2 - 3



Explanation of the operating window Project creation
2.2.3 Sub-window area

The sub-window area is for displaying, reading, and writing parameters, and for displaying the infor-
mation read from the inverter. Select a function in the [Window] menu or click an icon on the toolbar
to switch the windows in the sub-window area.

 Fig. 2-4:  Details of the sub-window area

No. Name Function / description

� Tab

Displays the names of functions in tab format.
Click a tab to move the corresponding sub window to the front and operate it.
Drag a tab to change the order of the sub windows.
Click the ? button on the tab to close the corresponding sub window.
(When the window cannot display all the tabs, the tabs can be scrolled by the button.)

� Sub-window 
selection button

Displays a list of the displayed sub windows. Select a sub window from the list to display 
it front.

� Sub-window 
display area Displays a function window of FR Configurator2.

Tab. 2-4: Details of the sub-window area

�

� �
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Project creation Explanation of the operating window
2.2.4 Menu bar and toolbar

The window of a desired function can be displayed by selecting it from the menu or on the toolbar. 

Menu Pull-down menu Toolbar
icon Function / operation

Project

New... Displays the system setting window.

Open... Opens a project file (*.frc2).

Close... — Closes the project file (*.frc2).

Save
Saves the project file (*.frc2). When the project file (*.frc2) 
has not been read or not created yet, the "Save As" window 
is displayed to save the project file.

Save As... — Names the current setting and saves it as a project file (*.frc2).

System setting — Used to check and change the system setting.

Print preview — Used to check the print screen of the selected sub window.

Print... Prints the selected sub window.

Exit FR Configurator2 — Exits FR Configurator2.

View

System — Shows or hides the system toolbar.

Call function — Shows or hides the call function toolbar.

Status bar — Shows or hides the status bar.

Docking Window/Project window Shows or hides the project window.

File�

Open... Opens a file related to the function of the sub window that is 
displayed front.

Import...
Imports files (*.gp4 or *.st1) when the graph window is opened. 
Use this function to compare them with the previous waveform 
data by displaying them together.

Save As... Saves the data related to the function of the sub window 
that is displayed front as new data with a name.

Save image in file... Saves the graph window as graph data (*.jpg or *.emf) when 
the graph window is opened.

Tab. 2-5: Menu/Toolbar list
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Explanation of the operating window Project creation
Parame-
ter list 
(Z)�

PU — Activates the PU operation mode.

EXT — Activates the External operation mode.

NET — Activates the NET operation mode.

Batch read Reads all the set values of the parameters of the 
selected inverter.

Read Reads the set value of the selected parameter of the 
selected inverter.

Batch write Writes all the parameter setting values entered in the setting 
field to the selected inverter.

Write Writes the set value of the selected parameter to the 
selected inverter.

All clear
Returns all parameters which can be cleared including cali-
bration parameters and terminal function selection parame-
ters to their initial values.

Parameter clear Returns parameters excluding calibration parameters and 
terminal function selection parameters to their initial values.

Verify
Verifies the set values of the parameters set in FR 
Configurator2 with those of the parameters written in the 
inverter.

Settings by 
function/
Motor

Motor setting — Displays the window for the motor and the control method setting

Offline auto
tuning — Displays the window to perform offline auto tuning.

Settings by 
function/
Terminal

Output terminal 
(FM/CA) calibration — Displays the window to calibrate terminal FM/CA.

Output terminal
(AM) calibration — Displays the window to calibrate terminal AM.

Input terminal
assignment — Displays the window to assign functions to input terminals.

Output terminal
assignment — Displays the window to assign functions to output terminals.

Analog input
terminal 2
calibration

— Displays the window to calibrate terminal 2.

Analog input
terminal 4
calibration

— Displays the window to calibrate terminal 4.

Settings by 
function/
Trace

Trace setting — Displays the window for the trace-related setting.

Trace command — Displays the window to perform trace commands such as 
sampling start/end.

Menu Pull-down menu Toolbar
icon Function / operation

Tab. 2-5: Menu/Toolbar list
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Project creation Explanation of the operating window
Graph 
(Z)�

Screen copy Saves the entire sub window as image data (*.bmp) to the 
clipboard.

Scale optimization
Adjusts the scale of the vertical axis and the position of zero 
so that the entire waveform of the selection history can be 
displayed in the window.

Moving mode Used to scroll the displayed waveform data.

Zoom-in mode Used to zoom in the specified area of a waveform.

Cursor Shows or hides the cursor on the screen.

Grayout Switches the display color (color or gray scale) of the wave-
form and the graph on the screen.

Overwrite Enables or disables overwriting for all the histories.

History management... Shows or hides the waveform history screen.

Property window/
Setting — Shows or hides the setting tab.

Property window/
Indication — Shows or hides the indication tab.

Property window/
Cursor — Shows or hides the cursor tab.

Batch 
monitor 
(Z)�

Pause Pauses the acquisition of the monitor data.

Resume Resumes the acquisition of the monitor data.

Setting... Sets the monitored item to be displayed.

I/O 
terminal
monitor 
(Z)�

Pause Pause the acquisition of the I/O terminal monitor data.

Resume Resumes the acquisition of the I/O terminal monitor data.

Faults his-
tory (Z)�

Faults history clear Clears the faults history of the inverter.

Inverter reset Resets the inverter.

Opera-
tion 
mode 
(Z)�

PU — Activates the PU operation mode.

EXT — Activates the External operation mode.

NET — Activates the NET operation mode.

Parame-
ter

Parameter list... Displays the "Parameter list" window in the sub-window area.

Convert... — Displays the "Convert" window in the sub-window area.

Monitor

Graph... Displays the "Graph" window in the sub-window area.

Batch-Monitor... Displays the "Batch monitor" window in the sub-window area.

I/O terminal monitor... Displays the "I/O terminal monitor" window in the sub-win-
dow area.

Diagnose
Faults history... — Displays the "Faults history" window in the sub-window area.

Serial number... — Displays the "Serial number" window in the sub-window area.

Test oper-
ation Test operation... Shows the command sending section of "Test operation".

Menu Pull-down menu Toolbar
icon Function / operation

Tab. 2-5: Menu/Toolbar list
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Explanation of the operating window Project creation
� The function menu related to the front sub window is displayed. When no sub window is
displayed in the sub-window area, these items are not displayed on the menu bar. 

Communication management

Online/offline can be switched for communication between FR Configurator2 and the inverter from
the menu on the toolbar.

The online/offline condition of communication between FR Configurator2 and the inverter can be
checked by the icon that is displayed.

Tool

Developer... Starts Developer.

USB memory parameter copy file
function edit Starts the USB memory parameter copy file editor.

Window

Cascade — Cascades sub windows.

Tile horizontally — Tiles sub windows horizontally.

Tile vertically — Tiles sub windows vertically.

Arrange icons — Arranges sub windows that are displayed as icons.

Close all — Closes all the sub windows.

Reset window layout — Resets the layout and the sizes of the toolbar, docking win-
dows, and sub windows to each initial status.

Opened sub window
(Example) Parameter list 1 — Select this item to display the opened sub window.

Help
FR Configurator2 help... Starts the help.

About... — Opens the "About" window.

Fig. 6-5: Communication management

Display Status

Offline

Online

Tab. 2-6: Communication status

Menu Pull-down menu Toolbar
icon Function / operation

Tab. 2-5: Menu/Toolbar list
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Project creation Explanation of the operating window
2.2.5 Status bar

The status bar displays the operation mode of the inverter, the model information etc.

 Fig. 2-6: Details in the status bar

No. Name Function / description

� Window status display Displays the function description when the mouse cursor is on an item on the menu bar or 
an icon on the toolbar.

� Station information Displays the model information of the inverter that is selected in the project tree. The dis-
play format is "Station number: Inverter model".

� Keyboard status 
„CAP“: Black = Caps Lock: ON, Gray = Caps Lock: OFF

„NUM“: Black = Num Lock: ON, Gray = Num Lock: OFF

Tab. 2-7: Details in the status bar

� � �
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File operation and print Project creation
2.3 File operation and print

2.3.1 List of file types

✔: Available,
—: Unavailable)

2.3.2 Open the file

Opening a project file (*.frc2)

This function reads the information of each function window that is saved in a project file (*.frc2), such
as model information and parameter setting values, and reflects it to the windows.

Select [Open] in the [Project] menu or click  on the toolbar to display the "Open the file" window.

To read a saved file, select the target file, then press the [Open] button. Regardless whether each func-
tion window is shown or hidden, the information of the opened file is reflected to FR Configurator2.

Extension Description Window Open Save Import Refer to

*.frc2

Manages the system setting, 
model information,
parameter list, sampling data of 
graph, and data of the
batch monitor with a single file.

All windows ✔ ✔ — 2.1.2

*.gp4

Holds the waveform data sam-
pled by the graph function. The 
saved waveform data can be 
displayed again by opening the 
file with the graph function.

Graph

✔ ✔ ✔

3.3
*.csv

Holds the waveform data sam-
pled by the graph function in 
the text file format.

— ✔ —

*.st1
Holds the operating status of 
the inverter in a USB memory 
tracing it.

✔ — 4

*.jpg Holds the waveform data of the 
displayed graph window as an 
image file.

— ✔ —

*.emf — ✔ —

*.csv
Holds the acquired serial num-
ber of the inverter in the text file 
format.

Serial number — ✔ — 3.6.2

*.pr4 Holds the parameter setting val-
ues set in FR Configurator2.

Parameter list
✔ ✔ —

3.1
*.xls Holds Parameter List data in 

Microsoft Excel format. — ✔ —

*.cp1
Holds the parameter setting 
that has been copied from the 
inverter to a USB memory 
device.

USB memory
parameter 
copy file edit

✔ ✔ — 3.9

Tab. 2-8: List of file types
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Project creation File operation and print
Open the file of each function

The information of files having an extension *.gp4, *.pr4, or *.cp1 can be imported and displayed on

the screen by clicking  on the toolbar of each function window while the corresponding function

window is displayed.

2.3.3 Save the file

Projektdateien (*.frc2) speichern 

Select [Save As] in the [Project] menu or the [File] menu or click  on the toolbar to display the

"Save As" window. Check the save destination, name a file, and save it.

Select [Save] in the [Project] menu or the [File] menu to overwrite the file. When saving a file for the
first time, "Save As" window is displayed.

2.3.4 Import the data (*.gp4)

By importing the saved data (*.gp4) of the "Graph", the information of the data can be displayed

on the "Graph" sub window. Select [Import] in the [File] menu or click  on the toolbar to dis-
play a window for selecting the importing file.

2.3.5 Print

The windows of "Parameter List" or "Graph" can be printed. Select [Print...] in the [Project] menu or

click  on the toolbar.

NOTES The comments entered in the system setting window are printed in the comment field of the
parameter list.

The graph drawing area is printed in black. To print the area in white, turn ON the grayout
setting before printing.

The displayed position in the print preview may differ from the actual printed position on a print.
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Function Parameter list
3 Function 

3.1 Parameter list

To display the "Parameter list", select [Parameter list...] in the [Parameter] menu, or the "Parameter list"

can be displayed by clicking  on the toolbar. "Parameter list" cannot be displayed if no project file

has been created, or if no project file is open.

NOTES FR Configurator2 parameter list supports the latest inverter at the time of FR Configurator2
upgrade. The setting range, initial value, number of parameters, etc., may be different with the
inverter before upgrading (additional functions).

Although the parameter name of the instruction manual and the parameter name of FR
Configurator2 may be different, there is no difference in the parameter function.

Pr.296 and 297 do not appear in the parameter list. Pr.296 and 297 will not change even if parame-
ter settings of another inverter are read. Change Pr.296 and 297 from the operation panel or the
parameter unit.

 Fig. 3-1: Details in the window "Parameter list"

No. Name Function/description

�

St. No. (Station number) Selects a station registered in the project.

Operation mode switch The inverter operation mode can be switched by selecting the operation mode button.

Operation mode indication Shows the operation mode.

�

Batch read Selects a station registered in the project.

Read The inverter operation mode can be switched by selecting the operation mode button.

Batch write Writes all the selected parameter setting values in the setting value column to the 
selected inverter.

Write Writes all selected parameter setting values to the selected inverter.

All clear Returns all parameters which can be cleared including calibration parameters and 
terminal function selection parameters to their initial values.

Parameter clear Returns parameters excluding calibration parameters and terminal function selec-
tion parameters to their initial values.

Verify Verifies the parameter settings, initial values and parameter files (*.pr4) set in FR 
Configurator2 against such settings already written to the inverter.

Settings by function Perform motor, terminal, and trace settings by function.

Tab. 3-1: Details in the window "Parameter list"

�

�

�

�
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Parameter list Function
�

Open Displays the "Open" dialog box for a parameter file (*. pr4) to be opened.

Save as

Shows the "Save as" dialog box. Verifies the save location, and saves with the spec-
ified [File Name]. The extension for savable parameter information files is *.pr4. 
The parameter list data can also be saved in the Microsoft Excel file format (*. xls) 
by using "File Type" in the "Save as" dialog box.

Undo Returns the edited parameter setting value to the setting value before editing.

Redo Redoes the setting value changed by "Undo".

Search Searches for the input character string from within the parameter list.

Back Searches for the input character string in the downward direction.

Next Searches for the input character string in the upward direction.

Target item Specifies the column to search.

�

Number Shows the parameter number.
Calibration parameters (Pr.902, 903, 904, 905, etc.) will be shown with ( ).

Name Shows the parameter name.

Setting range Shows the setting range of the parameter setting value.

Minimum setting unit Shows the minimum setting unit of the parameter setting value.

Initial value Shows the factory default parameter setting values of the inverter.

Setting value Inputs the value to be written to the inverter. Selecting [Write] or [Batch write] will 
write the setting value field data to the inverter.

NOTE To display the explanation about a parameter on the help window, double-click the parameter in
the parameter list.

No. Name Function/description

Tab. 3-1: Details in the window "Parameter list"
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Function Convert
3.2 Convert

Parameter settings of the conventional models can be copied to the 800 series parameter settings in
the "Convert" window. To display the "Convert" window, select [Convert...] in the [Parameter] menu. 

Source Target

FR-A700 FR-A800

FR-F700(P) FR-F800

Tab. 3-2: Models compatible with the convert function

NOTES Although the parameter name described in this instruction manual and the parameter name dis-
played in FR Configurator2 may be different, there is no difference in the parameter function.

If an option non-compatible with the target inverter is connected to the source inverter, if a unit
for setting a parameter is fixed by the option while Pr.37 Speed display and Pr.144 Speed setting
switchover of the source inverter are set to change the unit, the setting of the source inverter is
copied unchanged to the target inverter.

(Example)
When the FR-A7NL option is connected to the source inverter FR-A720-0046, Pr.37 = "0" and Pr.144 =
"104", and the target inverter is the FR-A820-0046-1, Pr.37 = "0" and Pr.144 = "104" are copied
unchanged to the target inverter. Since the unit of the source inverter is "Hz" and the unit of the target
inverter is "r/min", the parameter setting in Hz is copied unchanged to the target inverter.
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Graph Function
3.3 Graph

The inverter output frequency, current, and other data is sampled, and the result is displayed in a
graph (waveform). Sampled data can be saved to a file (*.jpg, *.emf, *.gp4, or *.csv file), and sampling
data saved to a file can be read (*.gp4 file, or *.st1 import) and displayed.

The [Graph] window can be displayed by selecting [Graph] from the [Monitor] menu, or by clicking

 on the toolbar. There are two types of sampling methods:

There are two types of sampling methods.:

● High speed sampling (available only during USB connection)
Data is collected with the shortest sampling interval, approx. 0.125 [ms]. The target station of the
sampling is only 1 station.

● Monitor sampling
The sampling interval varies depending on communication settings (communication speed,
communication port) and the number of sampling items.

Trace data display 

Displays in the graph window the trace data that is saved to the USB memory by the inverter. 

Setting item Specifications

Sampling interval
High speed sampling:Set to between approx. 1 [ms] (mask count: 1) and approx 20 [ms] (mask count: 30).
Monitor sampling:Set to the range from 50 [ms] to 60000 [ms] (varies due to communication speed,
communication port, and number of sampling items)

Sampling time [ms] High speed sampling: Maximum = (mask count +1) x 4000
Monitor sampling: Maximum = sampling interval x 4000

Analog data Analog data for 4 channels can be sampled.

Digital data Digital data for 4 channels can be sampled.

Tab. 3-3: Specifications

Setting item Specifications

Analog data Analog data for 8 channels can be displayed in the graph window.

Digital data Digital data for 8 channels can be displayed in the graph window.

Tab. 3-4: Specifications

NOTES Running other applications during high speed sampling, or performing personal computer file
operations during high speed sampling, etc., will cause communication errors (error code
0x80020007 or 0x80020008) or buffer overflow errors to occur, and data will not be able to be dis-
played correctly. In this case, execute such countermeasures as terminating the other applica-
tions, refraining from operation of FR Configurator2, and increasing the mask count setting of the
sampling interval.

The sampling interval varies depending on the inverter control method and presence/absence of
plug-in options.
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Function Graph
Graph window

 Fig. 3-2: Details in the window "Graph"

No. Name Function/description

� Toolbar Allows operation of the file, history control, and graph display settings.

� Properties Setting of the measurement conditions, display conditions, and cursor can be done in the 
properties.

� Sampling item column
Displays the contents of the analog CH and digital CH set by [Waveform] in the 
settings tab of the
condition properties.

� Measurement 
start/stop button

  Starts sampling.

  Stops sampling. This button only appears when operating.

� Graph display area Displays the sampled data in a graph.

� Horizontal axis scrollbar Allows scrolling of the displayed section in the graph display area.

� Trigger position Shows the position in which the trigger completes. "T" on the graph horizontal 
axis denotes measuring time period.

Tab. 3-5: Details in the window "Graph"

NOTES  If a fault occurs during sampling, sampling continues. If a normal communication with inverter is
not maintained (communication error, etc.), the sampling stops.

During sampling, other communication tasks such as parameter reading are unavailable.

When parameter write is performed during measurement of graph, waveform data may be incorrect.

�

�

�

�

�

�

�
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Batch monitor Function
3.4 Batch monitor

"Batch monitor" monitors more than one inverter monitored item at a time. To show the "Batch mon-
itor" window, select [Batch monitor (D)] in the [Monitor] menu, or select [Batch monitor] from the pro-

ject tree or click  on the toolbar.

 Fig. 3-3: Details in the window "Batch monitor"

No. Name Function/description

�

Font size Changes the size of monitor item characters.

Pause Pauses acquisition of monitor data.

Resume Resumes acquisition of monitor data.

Setting Sets the monitor items to display.

�
No. Shows the monitor item number.

Item Shows the monitor item.

St. No. (Station number) Shows the acquired data of the corresponding station.

Tab. 3-6: Details in the window "Batch monitor"

�

�
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Function I/O terminal monitor
3.5 I/O terminal monitor 

The "I/O terminal monitor" window shows the signals assigned to the I/O terminals of the control circuit
and the ON/OFF status of the signals. To display the "I/O terminal monitor" window, select [I/O terminal

monitor...] in the [Monitor] menu, or click  on the toolbar.

 Fig. 3-4: Details in the window "I/O terminal monitor"

No. Name Function/description

�
St. No. (Station number) Select a station to display its I/O terminal monitor data.
Pause Temporarily stop the acquisition of the I/O terminal monitor data.
Resume Resumes the acquisition of the I/O terminal monitor data.

�

Input Terminal All the input terminals are displayed.
Input Signal Signal names assigned to the input terminals are displayed.
Input Status Input terminal status are displayed.
Output Terminal All the output terminals are displayed.
Output Signal Signal names assigned to the output terminals are displayed.
Output Status Output terminal status are displayed.

Tab. 3-7: Details in the window "I/O terminal monitor"

�

�

FR Configurator2  3 - 7



Diagnostics Function
3.6 Diagnostics

3.6.1 Faults history function

Select [Faults history...] in the [Diagnosis] menu to display "faults history" in the sub-window.

 Fig. 3-5: Details in the window "Faults history"

No. Name Function/description

�

St. No. (Station number) Selects a station of which fault history is to be displayed.

Faults history clear Clears the selected station's faults history. When selected, the confirmation window 
appears. Select [Yes] to clear the faults history.

Inverter reset Resets the selected station's inverter. When selected, the confirmation window 
appears. Select [Yes] to clear the faults history.

�
Current fault Shows the current fault.

Current warning Shows the current warning.

� Faults history
Shows a list of the faults history read from the inverter. The output frequency, output 
current, output voltage, energization time, and occurrence time at the fault are dis-
played together.

� Fault details Shows explanations of selected fault details, check points, and corrective actions.

Tab. 3-8: Details in the window "Faults history"

�

�

�

�
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Function Diagnostics
3.6.2 Serial number function

Select [Serial number...] in the [Diagnose] menu to display the "Serial number" window as a sub window.

 Fig. 3-6: Details in the window "Serial number"

No. Name Function/description

� Station number All the stations set in the project are displayed.

� Model Models of the connected inverters are displayed.

� Serial number Serial numbers of the connected inverters are displayed.

Tab. 3-9: Details in the window "Serial number"

�� �
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Test Operation Function
3.7 Test Operation

Select [Test operation...] in the [Test operation] menu to display the test operation window. 

E
Warning! 

If communication fails (due to, for example, cable disconnection), the inverter cannot be 
stopped from the personal computer. This may cause hazardous conditions, resulting in death 
or severe injury.

Ensure safety by, for example, enabling signal loss detection (Pr.122, Pr.336, or Pr.548) or
externally setting a stop device.

 Fig. 3-7: Details in the window "Test operation"

No. Name Function/description

� ST. (Stationsnummer) Selects a station to perform test operation with.

� PU, EXT, NET
(Operation mode switch) Switches over the inverter's operation mode.

� Operation mode

PU PU operation mode

EXT External operation mode

NET NET operation mode

PU + EXT External/PU combined operation mode

— Indicates that the operation mode information was not 
acquired properly.

No display Nothing is displayed when offline.

Tab. 3-10: Details in the window "Test operation"

�

��

�

�

�

3 - 10



Function Test Operation
�

Operating status

FWD Rotating forward

REV Rotating reversely

STOP Stopped

ALARM Being stopped by the fault

— Appears when operating status information acquisition fails.

No display Nothing is displayed when offline.

Operation command

STF During forward rotation command

STR During reverse rotation command

— Indicates that the operating status information was not 
acquired properly.

No display Nothing is displayed when offline.

� Setting Set the running frequency.

� Run/Stop command
buttons Sends the run/stop commands.

NOTES
Open the batch monitor window to check the output frequency during test operation.

If FR Configurator2 had to be terminated, stop the operation by sending an operation stop com-
mand to the inverter.

Do not press an individual operation button, such as [Forward rotation] or [Reverse rotation],
repeatedly. Doing so may make the FR Configurator2 operation unstable. If operation continues
unintentionally, press [Stop] to stop operation.

When the following action is performed due to the Windows operation method, operation may
continue without the [Forward rotation] or [Reverse rotation] button being held down. Press the
[Stop] button to stop operation. Drag the mouse cursor off the button while holding down the
[Stop] button.

No. Name Function/description

Tab. 3-10: Details in the window "Test operation"
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Developer (PLC function) Function
3.8 Developer (PLC function)

Developer is used for creating sequence programs and writing them to the inverter to enable the use
of the PLC function of the inverter. 

Select [Developer] in the [Tool] menu to start "Developer" in a new window.

PLC function is used for customizing inverter operation to meet the machine specifications. PLC func-
tion operates the inverter according the input signals, or outputs signals and monitored values ac-
cording to inverter operation.

When using Developer, enable the PLC function of the inverter (Pr.414 PLC function operation selec-
tion ≠ 0). When Pr.414 = "2", the sequence start (SQ) signal from the external input terminal is valid re-
gardless of the Pr.338.

Switch the execution key (RUN/STOP) of the sequence program by turning the SQ signal ON/OFF. The
sequence program can be executed by turning the SQ signal ON. To input the SQ signal, set "50" in any
of Pr.178 to Pr.189 (input terminal function selection) to assign the function to a terminal.

Use the help function of Developer to refer to the contents of the manuals relevant to Developer. Re-
fer to the contents of the manuals from [Help] in the Developer menu.

NOTES Developer cannot be used if a communication speed setting of 4800 bps or less is set for PU connector
communication (Pr.118) or RS-485 communication (Pr.332). To use Developer, set 9600 bps or more.

To use the USB/RS-485 conversion cable DINV-U4, set RS-232C (initial setting) in the PC side I/F in
the Developer Connection Destination setting window.

A file created by GX Developer or GX Works2 cannot be used by Developer of FR Configurator2. Con-
versely, a file created by Developer of FR Configurator2 cannot be used for GX Developer or GX Works2.

 Fig. 3-8: The window "Developer"
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Function USB memory parameter copy file edit function
3.9 USB memory parameter copy file edit function

The USB memory parameter copy file editor is a dedicated software for editing setting values of USB
memory parameter copy files of the FR Configurator2 compatible models.

To start the USB memory parameter copy file editor, choose [USB memory parameter copy file edit] in
the [Tool] menu.

Open a copy of the parameter file to display the parameter list in the sub-window area. The parameter
list shows the parameter names, setting ranges and initial values. You may edit the values that have
been read from the USB memory and write the values into the inverter.

To display the explanation about a parameter on the help window, double-click the parameter in the
parameter list.

 Fig. 3-9: Details in the window "Editor"

No. Name Function/description

� Menu

File Open, close or save the USB memory parameter copy file (*.cp1). 

View Switches between show/hide of the "System", "Edit", "Search" or "Verify" toolbar.

Tool/
Verify

A list of differences between the USB memory parameter copy file to verify 
(*.cp1) and the parameter initial values or the
parameter setting values of the verify destination file (*.cp1) can be dis-
played. Parameter setting values cannot be input to the verify source and 
verify destination cells.

� Toolbar

Undo Returns the edited parameter setting value to the setting value before editing.

Redo Redoes the setting value changed by "Undo".

Search Inputs the character string, and searches for a matching character string 
from within the parameter list.

Verify
Verifies the setting value in the USB memory parameter copy file (*.cp1) with 
the initial value or setting values in other USB memory parameter copy files 
(*.cp1)

Back Locations that contain the matching character string will be selected from the 
selected parameter list search column from the bottom.

Next Locations that contain the matching character string will be selected from the 
selected parameter list search column from the top.

Target item Specifies the column to search

� Parameter list and 
setting values

Shows the parameter setting values saved to the USB memory parameter copy file, and inputs 
the setting values to be written to the inverter. Setting values cannot be set as blank.

Tab. 3-11: Details in the window "Editor"

�

�
�

FR Configurator2  3 - 13



USB memory parameter copy file edit function Function
NOTES Edited setting values are not checked when saving the USB memory parameter copy file or when
writing to the inverter. Therefore, even values that cannot normally be set to the inverter (setting
range, write-limited values) are written to theinverter. In this case, because operation of the
inverter cannot be guaranteed, change setting values with extreme caution.

Changing a parameter by FR Configurator2 may affect other parameter settings.

When using the FR-A820-55K (03160) or FR-A840-55K (01800), do not change Pr.570 Multiple rat-
ing setting from SLD or LD rating (Pr.570 = "0 or 1") to ND or HD rating, or vice versa.

Do not change the Pr.71 Applied motor and Pr.450 Second applied motor settings from an induc-
tion motor to a PM motor or vice versa.

Calibration parameters cannot be set.

Parameter setting values cannot be input to the verify source and verify destination cells.
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